A Practical Guide for Locating, Transforming, and Using GIS Data for Hydrologic Model Development

By: William J. King
August 1999

Presented to:
The Department of Civil and Environmental Engineering
Brigham Young University

COLLEGE OF
ENGINEERING AND TECHNOLOGY
BRIGHAM YOUNG UNIVERSITY
PROVO, UTAH
A Practical Guide for Locating, Transforming, and Using GIS Data for Hydrologic Model Development

By: William J. King
August 1999

Presented to:
The Department of Civil and Environmental Engineering
Brigham Young University
This project, by William J. King, is accepted in its present form by the Department of Civil and Environmental Engineering of Brigham Young University as satisfying the project requirement for the degree Master of Science.

E. James Nelson, Committee Chair

LaVere B. Merritt, Committee Member

A. Woodruff Miller, Committee Chair

T. Leslie Youd, Department Chair

Date
Introduction

The motivation behind this master's project was to do the necessary research and write a paper that was published in the American Society of Civil Engineers (ASCE) conference proceedings of 8 August, 1999 in Seattle, WA. The project was directed by Dr. Jim Nelson along with considerable help from Nawajish Sayeed Noman, Colby Manwearing and Chris Smemoe (EMRL developers). In an effort to leave behind a tangible tool to be used by hydrologic modelers, a web page was designed that represents the majority of the work accomplished in the project. This web page can be viewed at: http://www.emrl.byu.edu/gishydrodata/. The contents of the internet site are located in the appendix of this write-up. What appears in the body of this report is the actual paper submitted to the ASCE conference.

Future Work

The web page represents a work in progress and the EMRL department will employ additional students in the future to continue research and development to enhance the usability of the site. A bullet list to follow are some suggestions to aid future developers in this endeavor:

- The Examples section is at this point very small and an entire master's project could be spent on generating easy to follow "tip sheets" which implement the data and the descriptions found at the web site.
- Proprietary and local data "webs" should be developed. Though there are a variety of links to these data sources it would be beneficial to have better summaries of the data found at that site and how to implement the data.
- Considerable "bookmarking" needs to be done. As the Examples, Definitions, and Tool/Utilities "webs" are improved and added to, bookmarks (links) should be added better "interconnect" the web as a whole.
- Overall consistency and organization could be refined.
- Some type of rating system which describes how useful a specific link might be to the target audience might be employed (i.e., 5 stars for an excellent site).
- As the NED and NLCCP programs mature and reach completion, the data available at these internet locations should be well documented and examples should follow. These sites represent some of the newest/best/most applicable data available on the internet for hydrologic modeling in a GIS environment.
- The Prism program located at http://www.ftw.nrcs.usda.gov/prism/prism.html is very interesting and deserved a more thorough description etc.
- Along with the examples and descriptions to be added, graphical output and/or screen captures from WMS and ArcView are needed to make the site more dynamic and useable.
Table of Contents

Abstract ........................................................................................................... 1
Background ..................................................................................................... 1
Introduction .................................................................................................... 1
Data Sources for Hydrologic Modeling ......................................................... 2
  DEMs ........................................................................................................... 2
  Landuse ..................................................................................................... 4
  Soil type .................................................................................................... 5
  Digital Raster Graphics (DRG) ................................................................... 6
  Stream Gauge Data .................................................................................... 7
  Hydrography .............................................................................................. 7
  Precipitation Data ...................................................................................... 8
  Regional and Proprietary Data Sources ...................................................... 9
WMS-Hydro ................................................................................................... 10
  Data Transfer ........................................................................................... 10
Conclusions ................................................................................................... 10
References .................................................................................................... 10
Appendix ........................................................................................................ 12
  Data
  Tools
  WMSHydro
  Definitions
  Examples
  Search
  Home

List of Figures

Figure 1 - Watershed Delineation Using a 7.5 Minute DEM ............................ 3
Figure 2 USGS Land Use Land Cover Polygons ............................................. 4
Figure 3 STATSGO Hydrologic Soil Group Polygons .................................... 5
Figure 4 Portion of a Digital Raster Graphics File ........................................ 6
Figure 5 Historical Stream Gauge Data for the Provo River ............................ 7
Figure 6 River Reach Segment ..................................................................... 8
Figure 7 NOAA Atlas II Contours of Precipitation ....................................... 9
A Practical Guide for Locating, Transforming, and Using GIS Data for Hydrologic Model Development

E. James Nelson¹, Nawajish Sayeed Noman², William J. King³

Abstract
As Geographic Information Systems (GIS) and Internet technologies have matured during the past decade, spatial data for hydrologic modeling has become more accessible and usable. Digital elevation, land use, soil, and other data necessary for the development of computer simulations of hydrologic processes are now easily accessible from a variety of government and private web sites. However, because these data are often in a variety of locales, formats, and coordinate systems, it can be a daunting task to compile what is necessary for a given modeling project. Using the ArcView GIS as a base, an extension "WMS-Hydro" has been created for hydrologic modeling data development, storage, and presentation. This paper describes this extension, as well as a step by step approach to locate, process, and use geospatial data for hydrologic modeling. The approach outlined includes information about these key steps: 1) Finding and acquiring the data, 2) Reading raw data into ArcView, 3) Transforming the data to a consistent and useable coordinate system, 4) Extracting pertinent information for hydrologic models, and 5) Setting up and running a hydrologic model using the Watershed Modeling System (WMS). While the focus is on hydrologic data development for HEC-1 and other lumped parameter models, these same tools/steps could be used to develop data for distributed hydrologic models.

Background
At the same time geospatial data processing tools such as the Watershed Modeling System (WMS) have been developed, government agencies and private entities have been working to convert the available data sources to a digital format for easier distribution and implementation in hydrologic model development. Overcoming the obstacles of data acquisition, format, projection and connectivity are emerging issues limiting engineers from taking full advantage of GIS tools for automated watershed parameter development of rainfall runoff models.

Introduction
Developed by the Environmental Modeling Research Laboratory (EMRL) at Brigham Young University, WMS is a GIS related program that performs hydrologic data development by automating the following processes:

¹ Assistant Professor, Department of Civil & Environmental Engineering, Brigham Young University 242-D Clyde Building, Provo, Utah 84602 email:jimm@byu.edu
² Graduate Research Assistant, Department of Civil & Environmental Engineering, Brigham Young University 242 Clyde Building, Provo, Utah 84602 email:geosnsn@et.byu.edu
³ Graduate Research Assistant, Department of Civil & Environmental Engineering, Brigham Young University 170-B Clyde Building, Provo, Utah 84602 email:kingw@et.byu.edu
Delineate watersheds from digital elevations models (DEM)
- Compute runoff coefficients (i.e., NRCS curve number - CN) from digital landuse and soil layers
- Format the processed geospatial information into one of the commonly used hydrologic models such as HEC-1

While the tools for performing these key hydrologic modeling functions are well established in WMS and other similar GIS tools, data acquisition for a specific site often limits their use. The GIS community, led by government agencies such as the Federal Geographic Data Committee (FGDC), is working to standardize and make available data that can be used for a variety of GIS applications, including hydrologic model development. Further, the Internet is an ideal platform for the transmission of digital data compiled and archived by these government agencies. The challenge then for the practicing hydrologists is deciphering which data are available in a useful format, and can be quickly implemented in commonly used models such as HEC-1, HEC-HMS, TR-20, and others. In an effort to provide a tool that assists hydrologic engineers in managing and using GIS data sets for hydrologic modeling, the EMRL has developed an ArcView extension named WMS-Hydro that bridges the gap between data acquisition and model implementation. Often, available data have a number of limitations such as poor resolution, inconsistent projections, non-standard formats, and the need to merge or edit for hydrologic consistency.

The focus of this paper is to identify the available digital data on the Internet for rainfall/runoff model development, discuss the issues surrounding the use of this data, and how the WMS-Hydro extension can be used to facilitate its use in hydrologic modeling. Discussion will include data sources for use in commonly accepted lumped parameter models, however many of the data sources are equally applicable to the development of distributed hydrologic models. While this paper presents an overview, comprehensive information can be found at the EMRL department’s GIS Data for Hydrologic Modeling web page [1].

Data Sources for Hydrologic Modeling

There are several different data sources that can be useful for hydrologic model development. Three primary data layers that are important for almost every model include digital elevation models (DEM) for automated watershed delineation and geometric parameter estimation, and land use and soil classifications for the development of runoff coefficients such as the NRCS Curve Numbers (CN). In addition data layers such as digital raster graphics (DRG) files (scanned USGS topographic maps), hydrography (stream and watershed boundaries), precipitation, and stream gauge readings are valuable data sources in the model development process. The following sections summarize each of these data sources including descriptions, uses, availability, and limitations.

DEMs

Description
Digital Elevation Model (DEM) is the terminology adopted by the USGS to describe terrain elevation data sets in a digital raster form. The 1:250,000 (provides coverage in 1-by 1-degree blocks) and the 7.5-minute DEM (30- by 30-m data spacing, cast on a
Universal Transverse Mercator (UTM) projection are the two mostly commonly used DEMs in hydrologic modeling. Coverage is for the contiguous United States, Hawaii, and limited portions of Alaska.

![Image](image)

**Figure 1 - Watershed Delineation Using a 7.5 Minute DEM.**

**Uses**
DEM are used for automated watershed delineation and geometric parameter extraction such as slope, runoff distance and area.

**Data Sources/Issues**
- The USGS Geo Data web page [2] is an interactive web site allowing graphical selection of 1:250,000 or 7.5' quadrangles for download. The 1:250,000 files can be read directly into any standard GIS package without any data manipulation. The 7.5' quadrangles are in STDS format and currently require some intermediate formatting in order to be used by most GIS software. The SDTS format is emerging as a standard to store geographic data and will likely be supported by GIS programs as future releases are made available. More information about USGS DEMs can be found by accessing the GIS Data for Hydrologic Modeling web page.

- With watershed and water quality-based assessment in mind, the EPA recently developed the Better Assessment Science Integrating Point and Nonpoint Sources (BASINS) software program. BASINS [3] is an extension that runs within the ArcView platform. The BASINS program resulted in the development of this software as well as pre-packaged data for hydrologic modeling that includes the aforementioned USGS DEM data. The data developed by the BASINS program is a valuable resource in and of itself and can be independently applied to hydrologic modeling. The EPA has gone to great lengths to process NRCS StatsGO, USGS DEM and USGS Landuse/Landcover data into shapefile format. The data is packaged into predefined watershed boundaries each with their own USGS HUC (Hydrologic Unit Catalog) number. Predefined watersheds can be seen as both an advantage and disadvantage. If the region of study is smaller or larger than the predefined watersheds the GeoProcessing Wizard in ArcView can be employed to **clip** out the desired region. Refer to the GIS Data for Hydrologic Modeling web page.
web site to see a step by step example using the GeoProcessing Wizard.

- The National Elevation Dataset [4] (NED) is a new raster product assembled by the U.S. Geological Survey. NED is designed to provide national elevation data in a seamless form with a consistent datum, elevation unit, and projection. NED has a resolution of one arc-second approximately 30 meters for the conterminous United States, Hawaii, and Puerto Rico and a resolution of two arc-seconds for Alaska. NED will likely replace the other more common USGS formats and as higher-resolution or higher-quality data become available, the NED will be periodically updated to incorporate the best-available coverage [5].

**Landuse**

*Description*

Land use and land cover (LULC) are derived from thematic overlays registered to 1:250,000-scale base maps and a limited number of 1:100,000-scale base maps (corresponding to 0.5x1 or 1x2 degrees). Land use and land cover data provides information on urban or built up land, agricultural land, rangeland, forest land, water, wetlands, barren land, tundra, and perennial snow or ice. Classification codes for LULC maps can be found in the USGS Land Use and Land Cover Data table [6]. (see the EMRL GIS Data for Hydrologic Modeling tools page for a list of these classification codes).

![Figure 2 USGS Land Use Land Cover Polygons.](image)

*Uses*

The classification codes in LULC coverages can be used for automatic CN calculation in GIS programs such as WMS. Also required to obtain a CN is a NRCS soil type coverage and a land use table.

*Data Sources/Issues*

- Data from the USGS Geo Data web page [7] is an excellent source of "free" landuse data on the Internet. The LULC data are available in two different formats. The first format was developed as a part of the Geographic Information Retrieval and Analysis System (GIRAS). This data structure evolved as the USGS developed the LULC program in the late 70's. The other format is the Composite Theme Grid (CTG) format. This format is grid cell oriented instead of polygonal.

- The EPA's BASINS core data [8] also contains landuse data conveniently packaged in a shapefile format. It is actually the same GIRAS LULC data described above but converted to the more common shapefile format and associated with predefined/delineated watersheds based on the USGS HUCs (Hydrographic Unit Codes).
- The USGS is currently developing the *National Land Cover Characterization Project* (a subproject of the LCCP Land Cover Characterization Project) which will provide a consistent landuse coverage, in terms of resolution and projection. This is gridded/raster landuse data which has been derived via satellite imagery. The data will be stored in a Geo-TIFF format in the Conical Equal Area projection. This landuse data will be greatly superior because of the increased resolution and the more recent (1992) estimations of land use as opposed to the status-quo which uses much older data. Figure 2 (see previous page) is a landuse image taken from the NLCCP web site.

**Soil type**

*Description*

The NRCS is the primary supplier of soil type data. They have produced these data in three different classifications (resolutions): NATSGO (National Soil Geographic Database), STATSGO, (State Soil Geographic Database) and SSURGO (Soil Survey Geographic Database). Information such as particle size distribution, bulk density, available water capacity, soil reaction, salinity, and hydrologic soil group is included for each major layer of the soil profile.

![Figure 3 STATSGO Hydrologic Soil Group Polygons.](image)

*Uses*

- SSURGO, the most detailed level of information, is used primarily for farm and ranch conservation planning; range and timber management; and county, township, and watershed resource planning and management.
- STATSGO is used primarily for river basin, state, and multicounty resource planning, management, and monitoring. Soil maps for STATSGO were made by generalizing the detailed soil survey maps. Where more detailed maps are not available, data on geology, topography, vegetation, and climate were assembled, together with satellite images.
- NATSGO is used primarily for national, regional, and multistate resource appraisal, planning, and monitoring, and is under development.

*Data Sources/Issues*

- National STATSGO Database Data Access web page [9] provides the most widely used (for hydrologic modeling) soil type data. Data is available in DLG-3, Arc/Info 7.0 coverage, and GRASS 4.13 vector formats (see the GIS Data for Hydrologic Modeling "soil type" page, it has a more detailed description of managing this data).
As part of the BASINS “core” data, soil type and the necessary HYGRP (hydrologic soil group) field are included as shape and .dbf files, respectively. This data set provides a soil association map in ArcView shapefile format for the conterminous United States. The shapefiles have been prepared and distributed by EPA regions. This data is a subset of the original STATSGO data developed by the National Cooperative Soil Survey. As a necessary part of a rainfall/runoff model, the soil data from the EPA is a quick and useful alternative to NRCS STATSGO data that require some formatting before their implementation into a model.

Digital Raster Graphics (DRG)

Description
A digital raster graphic (DRG) is a scanned image of a U.S. Geological Survey (USGS) standard series topographic map, including all map collar information. The image inside the map neatline is georeferenced to the surface of the earth and fit to the Universal Transverse Mercator projection [10]. Besides DRG images there are other file types including, but not limited to, arial photography and topographic images that combine the image with georeferencing information. Originally the image (TIFF) and georeferencing information (TWF - TIFF World File) were packaged separately. The GEOTIFF [11] format, which contains both the image and referencing data, is an available option though many GIS systems currently have difficulty reading this new format.

Figure 4 Portion of a Digital Raster Graphics File.

Uses
Background images serve to reinforce spatial reliability in a conceptual model and are effective visualization tools for orientation and presentations. Geographic orientation allows the modeler to visualize the relationship between model input/output and topographic features of a region.

Data Sources/Issues

- The Digital Raster Graphics Program [12] has a database of all the 7.5' topography images for the entire United States provides this product for a base price and additional fees for each additional 7.5' quadrangle ordered. There are also a number of web sites that have compiled free DRG images [13] for individual states.
- The PASA data system developed by a joint effort between Penn State
University and the State of Pennsylvania has a small library of *.drg files. In addition the PASDA ftp site has almost the entire state in DOQQ format (Digital orthoquarterquads) which have the same name of their representative topographic quadrangles but with a NW, SW, NE, SE assigned indicating which section of a 7.5' quadrangle they cover.

Stream Gauge Data

Description

Stream stage data is simply the water surface elevation of a particular stream at a given time. Stage data is reported over the course of a water year.

![Figure 5 Historical Stream Gauge Data for the Provo River.](image)

Uses

While not generally used inside of a GIS, these data are invaluable during the calibration of any rainfall/runoff model.

Data Sources/Issues

- The USGS has developed an interactive web page for real-time stream stage data. This page allows graphical selection of the region of interest and then displays the current data available for the selected river/stream.
- NWIS - National Water Information System [14] has archived historical records of daily streamflow and peak flows for almost 20,000 stations. Some records go back a century. Figure 5 above is an example of the type of historical data that can be graphically generated for any number of river and stream gauge stations in the United States.

Hydrography

Description

Hydrography is the study of seas, lakes, rivers, and other bodies of water with regard to the measurement of flow and investigation of the behavior of streams. Special reference to the control, utilization of waters, measurement of tides and currents, and the surveying,
sounding, and charting of bodies of water are additional aspects of hydrographic investigations.

![River Reach Segment](image)

**Figure 6 River Reach Segment.**

**Uses**
Of specific interest in hydrographic analysis are stream reach files (referred to as RF3 files). RF3 contains over 3,100,000 individual hydrographic features (reaches) and over 93,000,000 coordinate points. They provide an excellent means of finding and developing stream network and watershed information for many different kinds of hydrologic and hydraulic models.

**Data Sources/Issues**
- National Hydrography Dataset -- The National Hydrography Dataset (NHD) contains a comprehensive archive of digital spatial data describing surface water features such as lakes, ponds, streams, rivers, springs and wells. Within the NHD, surface water features are combined to form "reaches," that provide the framework for linking water-related data to the NHD surface water drainage network. These linkages enable the analysis and display of water-related data in upstream and downstream order [15].
- The TIGER/Line files are a digital database of geographic features, such as roads, railroads, rivers, lakes, political boundaries, census statistical boundaries, etc. covering the entire United States. The database contains information about these features such as their location in latitude and longitude, the name, the type of feature, address ranges for most streets, the geographic relationship to other features, and other related information. They are the public product created from the Census Bureau's TIGER® data base of geographic information. The data layers are delivered in industry-standard shapefile format so they are easily accessible with many GIS software products [16].

**Precipitation Data**

**Description**
Precipitation data are an important part of any hydrologic model. Several isohyetal maps showing depth/frequency for different geographic regions are available (Figure 7). Gridded NEXRAD data are also becoming more available, however their application in modeling is still suspect due to the fact that they are not adequately ground-truthed.
Figure 7 NOAA Atlas II Contours of Precipitation.

Uses:
Rainfall data are usually implemented in the model itself and rarely require the type of data management and manipulation that a GIS would provide. Notwithstanding, the necessity for actual rainfall data is very apparent in any hydrologic runoff model.

Data Sources/Issues
- NEXRAD [17] In addition to conventional reflectivity observations, this advanced radar uses the "Doppler effect" to measure motion of clear air and atmospheric phenomena within storms, up to a maximum distance of 230 km from the radar.
- Western Regional Climate Center [18] This site provides excellent data in the form of precipitation frequency maps. An interactive database allows the selection of a particular state precipitation frequency map for different storm combinations of frequency and duration (i.e., 100yr, 24 hr storm).

Regional and Proprietary Data Sources
Regional data, in almost every case, can be considered spatially superior to that of free and/or national data sets. The GIS Data for Hydrologic Modeling web page includes a number of these regional web sites. One such example is PASDA [19] (Pennsylvania Spatial Data Access), a joint project between Penn State University and the state of Pennsylvania where DEM data, derived from USGS DEMs are archived by county.

WMS-Hydro
In the past few years the availability of hydrologic modeling data layers, including digital elevations, stream reach, basin boundaries, land use, and soils, in GIS format has become common place. GIS has established itself as an excellent tool for data storage and management. Most of the data acquisition agencies all over the world have either developed or are planning to develop GIS-based databases. However different data formats, projection systems, and resolutions adopted by different agencies have made the use of these data for hydrologic modeling somewhat difficult. Though most of these data seem acceptable from a GIS point of view, the absence of continuity and consistent direction in a stream network and connectivity between different data layers such as basin, stream and outlet make these data inadequate for modeling purposes. The need for preprocessing interfaces to prepare and transfer data between GIS and the mathematical
model has become more important. In order to facilitate data transfer between GIS and hydrologic models, the EMRL developers have created the WMS-Hydro extension for ArcView. This extension can be used to prepare GIS layers and manage attributes without regard to the specific hydrologic model to be employed. The data transfer is done through a "super file" which is a collection of ArcView shapefiles and ASCII grid files supported by WMS. The capabilities of this extension are briefly described as follows:

- Prepares Stream Networks: For the development of a conceptual hydrologic model it is imperative that the streams are connected and represent a consistent direction of flow. WMS-Hydro provides necessary editing tools to perform these tasks.
- Creates Outlet Theme: Outlet is defined as the drainage point of a basin. WMS-Hydro compares the stream networks with the basin layer and creates outlets at the locations where a stream leaves the basin. To define the connectivity between these layers, WMS-Hydro also inserts vertices in stream and basin layers at the outlet locations.
- Manages Attributes: WMS-Hydro provides tools that manage attributes of basin, stream and outlet features through user friendly interfaces.
- Computes Composite Curve Number: Composite curve numbers are computed from land use and soil type layers using a mapping table. The CN values are automatically assigned to the basin attribute table.
- Develops Hydrologic Model Connectivity: In most commonly used mathematical models a watershed is represented by a "hydrologic tree" which defines the connectivity of basins and streams. WMS-Hydro automatically creates the "hydrologic tree" from basins and streams.
- Displays Model Results: WMS-Hydro is capable of importing and displaying the hydrologic model results graphically.

Data Transfer
The data transfer between WMS and WMS-Hydro is done using a WMS-ArcView “super file” which is a collection of shapefile and ASCII grids. WMS also creates similar file, which includes the geographic data and hydrologic model results as well. The WMS and the WMS-Hydro both has the capability of exporting and importing of this “super file”.

Conclusions
Education relative to the specific data necessary for lumped parameter hydrologic model implementation, increasingly "user friendly" GIS systems, and customized tools such as WMS-Hydro have rendered the previously intimidating field of "digital hydrologic modeling" more accessible to the common hydrologic modeller. Data sources and web locations for commonly used data layers have been identified and compiled at a comprehensive web site hosted by the EMRL. This data availability, combined with advances in GIS-based hydrologic modeling tools, are allowing hydrologic engineers to increase their productivity in modeling efforts.

References
Appendix
WMS/GIS Data Acquisition

Data Summary
The audience for this webpage is considered to be a somewhat experienced engineer/hydrologic modeler who has recently begun to format their model data via GIS applications such as ArcView and Arc/Info (link to CE 514 Arc/Info essentials page). It should be recognized that, in almost every scenario, local/regional data will be more precise/superior to the majority of the data described herein.

- Main data layers for the computation of a NRCS curve number
  - Digital Terrain / Topographic Data (aka DEM or elevation grid)
  - Landuse Data
  - Soil-type Data
- Supporting Data
  - Images
  - Precipitation Data
  - Hydrography
  - Stream Stage Data
  - TINs
- Data Issues
  - Geo-Referencing
  - Projection (coordinate system)
  - Data Format
- WMS Hydro

For problems or general questions regarding this web contact the webmaster.
Last updated: August 14, 1999.

DEM Data Sources

General Description
Digital Elevation Model (DEM) is the terminology adopted by the USGS to describe terrain elevation data sets in a digital raster form. The 7.5-minute DEM (30- by 30-m data spacing, cast on a Universal Transverse Mercator (UTM) projection) provides coverage in 7.5- by 7.5-minute blocks. Each product provides the same coverage as a standard USGS 7.5-minute quadrangle without overlap. Coverage is for the contiguous United States, Hawaii, and Puerto Rico. This is a data-set level implementation of the Federal Geographic Data Committee's Content Standards for Digital Geospatial Metadata.

Data Locations/Descriptions

- **USGS DEMs** -- United States Geologic Survey (USGS) Digital Elevation Models (DEMs)
- **EPA DEMs** -- DEMs packaged as shapefiles in predefined delineated watersheds (HUCs)
- **NED** -- Seamless, user defined DEMs produced by the USGS (still under construction)

For problems or general questions regarding this web contact the webmaster.
Last updated: August 14, 1999.

Background

LULC files are available free on the internet from the USGS National Mapping Program. The data layers include: land use and land cover, political units (state and county), census subdivisions, USGS hydrologic units, federal land ownership and state land ownership. Not all areas have all layers yet available. The data are available in units of 0.5x1 or 1x2 degrees corresponding to 1:100,000 or 1:250,000 USGS quadrangle maps.

The data are available in two formats, the Geographic Information Retrieval and Analysis System (GIRAS) and a Composite Theme Grid (CTG). The GIRAS is compact and somewhat complex vector based system that contains information on one data layer. It stores repeated sections of subsections that contain arcs, coordinates, polygons and arcs-by-polygon. The coordinate system is abbreviated UTM’s.

Classification codes for LULC maps can be found on the USGS Land Use and Land Cover Data homepage and in the tools/utilities page. The classification codes in LULC coverages can be used for automatic curve number calculation in WMS. You also need an SCS soil type coverage and a land use table to do this.

Landuse Links

- USGS Landuse Background and Instructions
- EPA Landuse Page -- The BASINS landuse data in shapefile format.

http://www.emrl.byu.edu/gishydrodata/landuse.htm 8/25/99
USGS Land Cover Characterization Program -- Higher resolution and more recent landuse data

For problems or general questions regarding this web contact the webmaster.
Soils

Soils Data Resources

The NRCS is the primary supplier of soil type data. They have produced these data in three different classifications (resolutions): NATSGO (National Soil Geographic Database), STATSGO, (State Soil Geographic Database) and SSURGO (Soil Survey Geographic Database). Information such as particle size distribution, bulk density, available water capacity, soil reaction, salinity, and hydrologic soil group is included for each major layer of the soil profile.

Data

EPA Soil Type Data
This data set provides a soil association map in ArcView Shapefile Format for the Contiguous United States. The shapefile is prepared and distributed by EPA regions. Selected attribute related tables which contain soil properties are provided. This data set is a subset of the original STATSGO data set developed by the National Cooperative Soil Survey.

NRCS Statsgo Data
STATSGO depicts information about soil features on or near the surface of the Earth. These data are collected as part of the National Cooperative Soil Survey.

Additional Resources

The National Soil Survey Center's

National Soil Data Access Facility (NSDAF)

http://www.emrl.byu.edu/gishydrodata/soils.htm

8/25/99
For problems or general questions regarding this web contact the webmaster.
Last updated: August 14, 1999.
A digital raster graphic (DRG) is a scanned image of a U.S. Geological Survey (USGS) standard series topographic map, including all map collar information. The image inside the map neatline is georeferenced to the surface of the earth and fit to the Universal Transverse Mercator projection.

Besides DRG images there are other file types including, but not limited to, arial photography and topographic images that combine the image with georeferencing information. Originally the image (TIFF) and georeferencing information (TWF - TIFF World File) were packaged separately. The GEOTIFF format, which contains both the image and referencing data, is an available option though many GIS systems currently have difficulty reading this new format.

Portion of a Digital Raster Graphics File.

Uses

Background images serve to reinforce spatial reliability in a conceptual model and are effective visualization tools for orientation and presentations. Geographic orientation allows the modeler to visualize the relationship between model input/output and topographic features of a region.

Data Sources/Issues
The Digital Raster Graphics Program has a database of all the 7.5' topographics images for the entire United States provides this product for a base price and additional fees for each additional 7.5' quadrangle ordered. There are also a number of web sites that have compiled free DRG images for individual states.

The PASA data system developed by a joint effort between Penn State University and the State of Pennsylvania has a small library of *.drg files. In addition the PASDA ftp site has almost the entire state in DOQQ format (Digital orthoquarterquads) which have the same name of their representative topographic quadrangles but with a NW, SW, NE, SE assigned indicating which section of a 7.5' quadrangle they cover.

Backdrop images such as .drg, .tif, and geo-referenced .tiff files (such as a tiff world file, *.tfw) are very useful for a hydrologic conceptual model. The images must be "geo-referenced" in order to properly utilize images in connection with already existing line and shapfile data. If latitude and longitude data are available for the site, the image can be registered in WMS. If the image is to be used in other GIS applications the Map to World-File extension in ArcView can be useful.

Topographic images can be located and purchased at the USGS National Mapping Information page. The USGS page also has an interactive "Map Finder" which can be useful if you don't have the exact geographic coordinates available. In addition, hard-copy 7.5 min topographic maps can be purchased online at this site.

For problems or general questions regarding this web contact the webmaster.
Last updated: August 16, 1999.

http://www.emrl.byu.edu/gishydrodata/images.htm
Precipitation data are an important part of any hydrologic model. Several isohyetal maps showing depth/frequency for different geographic regions are available (see figure below). Gridded NEXRAD data are also becoming more available, however their application in modeling is still suspect due to the fact that they are not adequately ground-truthed.

NOAA Atlas II Contours of Precipitation.

**Uses:**
Rainfall data are usually implemented in the model itself and rarely require the type of data management and manipulation that a GIS would provide. Notwithstanding, the necessity for actual rainfall data is very apparent in any hydrologic runoff model.

**Data Sources/Issues**
- **NEXRAD** In addition to conventional reflectivity observations, this advanced radar uses the "Doppler effect" to measure motion of clear air and atmospheric phenomena within storms, up to a maximum distance of 230 km from the radar.
- **Western Regional Climate Center** This site provides excellent data in the form of precipitation frequency maps. An
interactive database allows the selection of a particular state precipitation frequency map for different storm combinations of frequency and duration (i.e., 100yr, 24 hr storm).

**NEXRAIN**
Commercial site integrating and enhancing available NEXRAD and rain gauge data.

**Western U.S. Precipitation Frequency Maps**
Frequency - Duration maps (see image at the top of this page).

**Prism Data**
Improved precipitation data over moutainous regions. PRISM uses point measurements of climate data and a DEM to generate estimates of annual, monthly and event-based climatic elements. These estimates are derived for a horizontal grid, and are compatible for use on a GIS.

For problems or general questions regarding this web contact the webmaster.
Last updated: August 16, 1999.
Hydrography is the description and study of seas, lakes, rivers, and other bodies of water with regard to:

- The measurement of flow and investigation of the behavior of streams especially with reference to control or utilization of their waters.
- The measurement of tides and currents especially an aid to navigation.
- The surveying, sounding, and charting of bodies of water


Data Resources

ESRI has an ArcData site with links to a number of data sets that are free or are available for purchase. One which is Census Tiger 1995 Data. The archive contains boundary files based on 1992 TIGER/Line, standard extract files based on 1990 STF3A, Block statistics from STF1B, and enhanced migration files based on STP28, county to county. Within this free data set are a number of data layers organized into individual shape files based on data type within a specific county.

National Hydrography Dataset -- The National Hydrography Dataset (NHD) contains a comprehensive archive of digital spatial data describing surface water features such as lakes, ponds, streams, rivers, springs, and wells. Within the NHD, surface water features are combined to form "reaches," that provide the framework for linking water-related data to the NHD surface water drainage network. These linkages enable the analysis and display of water-related data in upstream and downstream order.

National HU Database -- The methodology described in the national instruction is used to construct the hydrologic unit maps in the NRCS National Hydrologic Unit database. Mapping scale is 1:24,000. The digitized
captures the watersheds (11 digit) and subwatersheds (14 digit) hydrologic units nested within the Catalog Units (Basins) as defined by the United States Geological Survey, (USGS) in earlier publications. The final product is to be a seamless, digital coverage, at the state level, meeting NMAPS. This level of detail is sufficient for use in natural resource planning and management. The user should be knowledgeable of hydrologic principles and the associated technologies.

Digitizing is done by line segment (vector) format in accordance with Natural Resources Conservation Service (NRCS) digitizing standards. The mapping b meet national map accuracy standards and are 7.5-minute topographic quadrangles. HU boundaries ending at quadrangle neatlines are joined by comput to adjoining maps to achieve an exact match. HU data are collected and archived in state coverages, and distributed as complete state coverage. Some data s include the names of the streams in each HU, or corresponding designations of watersheds and subwatersheds.

Streams:

Reservoirs:
http://water.usgs.gov/lookup/getspatial?reservoir

Hydrologic Unit Maps:

Hydrographic spatial data sets organized by theme:
http://water.usgs.gov/lookup/listgistheme

General (Commercial site):
http://www.adci.com/edppages/c4arc.htm

For problems or general questions regarding this web contact the webmaster.
Stream Stage Data

Historical Stream Gauge Data for the Provo River.

While not generally used inside of a GIS, these data are invaluable during the calibration of any rainfall/runoff model.

Data Sources

- The USGS has developed an interactive web page for real-time stream stage data. This page allows graphical selection of the region of interest and then displays the current data available for the selected river/stream.
- NWIS - National Water Information System has archived historical records of daily streamflow and peak flows for almost 20,000 stations. Some records go back a century. The figure above is an example of the type of historical data that can be graphically generated for any number of river and stream gauge stations in the United States.

For problems or general questions regarding this web contact the webmaster.
TINS are triangular facets representing topography. Each triangle or facet has an estimated slope, aspect and surface area. Since TINS are not regularly spaced like the lattice data structure there are several theoretical advantages of tins over grid data:

- Less points are needed to represent the topography---less computer disk space needed.
- Points can be concentrated in important areas where the topography is variable and a low density of points can be used in areas where slopes are constant.
- Points of known elevation such as surveyed benchmarks can easily be incorporated with TINS.
- Areas of constant elevation such as lakes can easily be incorporated into TINS.
- Lines of slope inflection such as ridgelines and steep canyons streams can be incorporated as breaklines in TINS to force the TIN to reflect these breaks in topography.

http://bonanza.lter.uaf.edu/~dverbyla/nrm341/tin98.html

TINS are a specific type of unstructured grid which are made up of layers of nodes and triangles. TINS are stored as an array of nodes and an array of triangles. Each layer is triangulated identically and has the same X and Y location data. Each triangle consists of three node IDs which index into the node list.

TINS, can be created manually in WMS with the use of a background topographic image or other survey data. This page will explain how to create in WMS bases off a background, registered, topographic image.
Register the background topographic image.

In the TINs pull-down menu (in the TIN module) select Vertex Options and turn off all the options and enter a default z-value (elevation of the contour in your topo that you're going to digitize).

In the TIN module of WMS select the Add Vertices to TIN tool.

Add TIN vertices along an individual contour (all vertices will have the same z-value).

Select Vertex Options in the TINs pull-down menu to change the default z-value for the next contour.

Continue this process until all user-defined contours are digitized.

In the TINs pull-down menu select Triangulate.

In the TINs pull-down menu select TIN Boundary -> Polygon.

In the Map Module, from the Feature Objects pull-down menu, select the Create TIN option.

For problems or general questions regarding this web contact the webmaster.

Tools/Utilities

**Water Resource Engineering Glossary**

**ArcView**

**Loading Extensions**
All extensions (*.avx files) must be saved to the \AV_GIS30\ARCVIEW\EXT32 folder.

**WMSHydro**

**Import 71**
IMPORT is a stand-alone program that converts an ARC/INFO interchange file (.e00) created on any operating system into a data file. If you receive ARC data in interchange format you can use IMPORT 71 to convert it to a data source in a format that can be a project or view in ArcView.

**Definitions**

**Examples**

**Projector**
Projector is one of the free extensions which ships with ArcView. There are many such extensions which are up by default. These extensions are found in the samples/ext directory under Arcview. For one of the extensions to be available within the program, the file must be copied to the ext (UNIX) or ext32 (PC) directory under Arcview. For the Projector extension to function correctly all files beginning with "prjctr" must be copied. The purpose of Projector is to convert a theme from projection to another. The steps to do so are presented below.

Steps to complete a change in projection:

1. Specify current system of units under view-properties
2. Start Projector (new green button at top right of pull-down menu; shows up after adding the extension)
3. Select the input projection parameters
4. Select output units
5. Select the output projection parameters
6. Select whether to recalculate area, perimeter and fields using the new units

Determine whether to add the projected shapefiles to the current view.
Select which view to add it to.
Give the new theme a name.

**Map to World File Creator**
This extension will help the user create a world file for an image by picking control points between the image and a projected feature theme. This extension takes advantage of ArcView being able to do a first order affine fit of the image when a world file is available for the image. A first order fit can shift the image up or down and stretch it in the vertical and/or horizontal direction. No this in mind because it will not "warp" or "rubber sheet" the image. So if you have photos that were created with the principle point coinciding or very close to it you should be able to get a reasonable fit. By that I mean the photos cannot be oblique which is caused by pitching or rolling of the platform carrying the image.

To use this extension place it in your ext32 directory from the file->extensions menu check the Image to World File Creator.

You should see a blue diamond on the Project Button.

Press this button to begin and you will be asked for the name of the image you want to create a World File for and the name of the Feature Theme you want to register.

On the left side of your tool bar you will see a new tool looks like a flag. Choose this tool and with it pick Grid Control Points (GCP's) that have the same spatial location for both the image and the feature theme.

i.e. Pick a point on the image. . . Pick a point on the feature theme that is the same location.

This constitutes 1 GCP pair.

now continue

Pick a point on the image. . . Pick a point on the feature theme that is the same location.

..
Continue doing this until you have at least 6 GCP pairs.

For a first order fit you need minimum of 3 pairs but recommended by all that you have twice the minimum set it up in the code so that you had to pick 6 pairs.

Once your GCP's are chosen minimize the two view open the table called Ground Control Point Table.

This table has 6 fields

field -> Use Pnts You will notice every record has this

field-> Input x For the image x coordinate

field-> Input y For the image y coordinate

field-> Output x For the output x coordinate

field-> Output y For the output y coordinate

field-> rms Will display the Root Mean Square for the image/feature for each record

You will notice a new button on the Table Button Bar a capitol C. This button will calculate the fit and rms for your control points. Press it and then look at the values in the RMS field.

Any one record that gives you a high rms value can turned off by typing OFF in the Use Pnts field.

When the Use Pnts field is ON the coordinate will be calculating the coefficients for the fit and thus in the file. When it is off that record will not be used.

Keep calculating the rms and turning records off until are satisfied with the total rms. Just keep in mind they have to have 6 GCP pairs ON for it to work.

Once you are done you should see a new button on Button Bar that looks like a pencil and paper. This button will write the world file. Press it and you will be asked to save the file. You should save it in the same directory.
the image itself.

When done the project will close and then you can open a new project and insert the image and feature the new view. Both of which should register.

**GeoProcessing Wizard Extension**

- **Clip** -- The clip option can be used to cut out a portion of one theme using the boundaries of another theme. For example, suppose you have two themes: one showing all of the roads in a state, and another county in that state. The clip option allows you to show the county theme, clip off the roads outside the county, and create a new view showing the county boundaries and the roads within the boundary.

- **Dissolve** -- Dissolving can be used to delete lines between adjacent polygons into a more simplified attribute. For example, consider a view showing a county where different foods such as corn, barley, and milo are grown. The lines between these areas can be deleted or dissolved creating a new region renamed as "agricultural".

- **Merge** -- Merging allows the user to combine features in a theme. For example, if you have a theme containing soil property polygons, you can merge these polygons that have the same land use attribute.

- **Intersect** -- The intersect command allows you to integrate two spatial data sets. Only the features that lie within each of the theme boundaries are preserved. For example, suppose you have two themes. One theme shows a map of the western states, and a second theme shows the Rocky Mountains. If these themes were intersected, a new theme would be created showing a view of the areas the Rocky Mountains intersect the western states.

- **Union** -- The union option can be used to create a new theme containing the features and attributes of two polygon themes. For example, suppose you have two themes; one theme shows where the soil liquefaction potential is high, and the other shows the areas with potentially large earthquakes. Their views can be merged to determine hazard areas.

Spatial Join -- The spatial join option takes two theme tables and joins them according to a specific field or a spatial attribute found in each theme. For example, if you have one theme that contains city names and another which contains the counties where the cities are located, a spatial join enables you to acquire the name of the county the cities are located in.

Spatial Analyst

ArcView Spatial Analyst introduces a broad range of powerful new spatial modeling and analysis features previously not available to desktop users. This new extension allows you to create, query, map, and analyze cell-based raster data and to perform integrated vector-raster analysis.

With Spatial Analyst you can:

- Convert feature themes (point, line, or polygon grid themes).
- Create raster buffers based on distance or proximity from feature or grid themes.
- Create density maps from themes containing points or features.
- Create continuous surfaces from scattered points or features.
- Create contour, slope, and aspect maps and hill of these surfaces.
- Do cell-based map analysis.
- Perform Boolean queries and algebraic calculations on multiple grid themes simultaneously.
- Perform neighborhood and zone analysis.
- Do grid classification and display, and more.

Unique to ArcView Spatial Analyst is the ability not only to work with raster-based data (including the ability to overlay, query, and display multiple raster themes) but also to do integrated raster-vector theme analysis by aggregating properties of a raster theme based on a overlaid vector theme. For example, direct mail can be focused on customers within complex polygons...
that are determined by spatial analysis of drive time proximity to service centers.

ArcView Spatial Analyst is particularly well suited for providing solutions to problems that require distance other continuous surface modeling information to be considered as part of the analysis. For example, sit suitability analysis often requires combining informa about slope (information best represented as raster as well as the location of roads and property bounda (information best represented as vector data) to arri the best location for a new facility. Spatial Analyst c only generate the appropriate surface representatio information from a variety of existing data sources, can also derive new information from the overlay of multiple theme types. The results are then used to s possible solutions to the original problem.


**ARC/INFO**

**SHAPEARC**
Writes shapefile spatial and attribute information to ARC/INFO coverage. Shapefiles store only one of t following feature types: line, point, multipoint or pol Polygon geatures may overlap and are converted to regions. Lines can optionally be converted as routes sections. Shape polygons are converted into region because there is no way to insure that polygon shap features do not overlap. If polygon topology is req the REGIONPOLY command can be used.

**REGIONPOLY**
Converts a regions subclass into a polygon coverage creates an INFO table containing overlapping region information.

**ARCSHAPE**
Writes feature attributes or info records to a new sh data file. The concept of shapefiles was adopted in ArcView version 2 to allow limited editing of theme information. ARCSHAPE creates three files to store t geometry and DBASE attributes (.shp, .shx, .dbf).

GRID TO ASCII

ASCII TO GRID

GENERATE
Adds features to a coverage. Coordinates for each f may be entered from the terminal or from a file. Coordinate read from an input file can be in x,y,z fo GENERATE ignores the z values if they exist.

GENERATE <cover>
If the coverage does not already exist GENERATE will create the coverage. Note: GENERATE creates new coordinate features, it does not create topology or attributes for these features (use BUILD or CLEAN for this).

PROJECTDEFINE
Interactive dialogue for entering the projection infor for a data set.
Below are a couple of screen captures from the Arc/ Help File.

WMS

Using Precipitation Data in a HEC-1 model
Using Precipitation Data in a WMS HEC-1 model In once the watershed delineated and the subasins are defined, a HEC-1 model can be developed. In WMS s the basin tool  . Double click on a drainage unit (al referred to as a subasin) and the Edit HEC-1 Parames dialogue will pop. From this dialogue select the Precipitation button in the top left corner of the dia The HEC-1 Precipitation dialogue will appear.
As seen above, there are four possible selections: N Precipitation, Basin Average, Gage and Hypothetical storm. For the Basin Average method a rainfall distribution series must be defined. Such as II 24 Hour. The Gage method requires at least three stations of available gage data from which a thiesse network is created. The Hyothetical storm allows the to define the storm distribution or enter the storm frequency as a percent to be converted to an annual rainfall.

**Other**

**NRCS Landuse Classification Table**
Classification Codes-first and second level categories

1 Urban or Built-Up Land
11 Residential
12 Commercial Services
13 Industrial
14 Transportation, Communications
15 Industrial and Commercial
16 Mixed Urban or Built-Up Land
17 Other Urban or Built-Up Land
2 Agricultural Land
21 Cropland and Pasture
22 Orchards, Groves, Vineyards, Nurseries
23 Confined Feeding Operations
24 Other Agricultural Land
3 Rangeland
31 Herbaceous Rangeland
32 Shrub and Brush Rangeland
33 Mixed Rangeland
4 Forest Land
41 Deciduous Forest Land
42 Evergreen Forest Land
43 Mixed Forest Land
5 Water
51 Streams and Canals
52 Lakes
53 Reservoirs
54 Bays and Estuaries
6 Wetland
61 Forested Wetlands
62 Nonforested Wetlands
7 Barren Land
71 Dry Salt Flats
72 Beaches
73 Sandy Areas Other than Beaches
74 Bare Exposed Rock
75 Strip Mines, Quarries, and Gravel Pits
76 Transitional Areas
77 Mixed Barren Land
8 Tundra
81 Shrub and Brush Tundra
82 Herbaceous Tundra
83 Bare Ground
84 Wet Tundra
85 Mixed Tundra
9 Perennial Snow and Ice
91 Perennial Snowfields
92 Glaciers

**SDTS Conversion**

**Background**

USGS 7.5-minute DEMs in SDTS format can be downloaded from the USGS GeoData home page. These DEMs are extremely useful, but WMS cannot currently import them. Fortunately, a utility written by Solom at the BLM exists. This utility converts SDTS DEM files to Arc/Info ASCII grid format. The Arc/Info ASCII grid files can then be read into WMS. The steps for reading Arc/Info ASCII grid files into WMS are:

1. Download the sdt2arc.exe utility.
2. Uncompress your SDTS files and convert them to Arc/Info ASCII grid format.
3. Import the Arc/Info ASCII grid(s) into WMS.

### Download the **sdt2arc.exe** utility

### Uncompress your SDTS Files and Convert to Arc/Info ASCII Grid Format

If you are using Windows, this step is fairly easy. You need to have WinZip. After downloading the SDTS files to your hard drive, create a single directory on your hard drive for each of your SDTS files. **HINT:** Each directory should have 8 or less characters in the SDTS file directory and all the levels of directories. No spaces should be used for directory names.

For example, C:\My documents\SDTS\aspen\ should not be used. Instead, use: C:\data\SDTS\aspen

Open each of your SDTS files in WinZip. For each of the SDTS files, change the "_tar" extension to "_tar.gz". Then, extract the file to the correct SDTS sub-directory. Move the sdt2arc.exe DOS executable file to each of the SDTS sub-directories. Bring up the DOS prompt and go to the SDTS directory...
the SDTS files you wish to convert. Alternatively double-click on the sdts2arc.exe executable in the directory containing the SDTS files you wish to convert. In either case, run sdts2arc.exe. When download and extract an SDTS grid file, 18 files extracted. One file is larger than all the rest, an "ce" for the 5th and 6th characters. This file is the SDTS "CELL" file. When you run the sdts2arc.exe program, you will have to enter 3 items:

1. The first 4 characters of your SDTS CELL file.
2. The desired output file name. Typically, you want to end your output file in ".grd". This file name extension is automatically added to the end of your output file name.
3. The 7th and 8th characters of your SDTS CELL file.

Here is what a successful run of the sdts2arc.exe program looks like:

T:\geoscms\sdtsdems\taberne>sdts2arc

Spatial Data Transfer Standard (SDTS)
SDTS to ARCINFO ASCII GRID Utility
SDTS2ARC BETA ver .004
Use only SDTS Raster/DEM Files
Another gis translation tool from
Sol Katz(skatz@blm.gov), May 1998.

Usage: sdts2arc (base_input_name)
(base_output_file) (cell id)
input file: 4 characters in position 1-4 of the base name
output file: output file without extension
layer id: 2 characters in position 7 and 8 of base name

Enter 1st 4 characters of base SDTS file name
(1234xxxx.DDF):
1189

Enter output file name (.GRD will be appended)
taberne

Enter the 2 characters in position 7 and 8 of the file name, (xxxxCE78): 10
Title: TABER NE, ID - 24000
Data ID: LAT:: 43.375 LONG:: -112.5 SCALE::
Map Date: 1994
Data set creation date: 19980128

cell width: 30.000000
cell height: 30.000000
rsnm: UTM
zone: 12
rows = 469, columns = 346
Range: max= 5517, min= 4730, void= -32767,
fill= -32766
LAT/LONG of the 7.5 USGS Quad
SW 368352.468750 4803526.000000
NW 368623.281250 4817408.500000
NE 378729.312500 4817218.500000
SE 378479.343750 4803336.500000
processing cells

End of Program

Import the Arc/INFO ASCII Grid(s) into WM

Start WMS.
Select the Import command from the File menu
Select the Arc/INFO grid->DEM option and select
The Import Arc/INFO grid dialog will appear.
Select the Add button in this dialog, select one
Arc/INFO ASCII grid files written from the sdts2a
program, and open it. You can add several Arc/
ASCII grid files in this manner. Select OK on th
Import Arc/INFO grid dialog after you are done a
all the files you wish. The Arc/INFO ASCII grid fil
be read into WMS.

Final note--Some SDTS grids are in feet, some
meters. You will need to figure out which grids
feet and which are in meters. After you do this,
will need to read the grids with the same units i
WMS, convert them to the units you are workin
export the DEM from WMS in Arc/INFO ASCII gri
format, and read all the files back into WMS in t
same units.

Using EPA DEM data (using the spatial analyst)

http://www.emrl.byu.edu/gishydrodata/tools.htm
extension in ArcView)

1. Go to [http://www.epa.gov/OST/BASINS/gisdat](http://www.epa.gov/OST/BASINS/gisdat) and select the state and watershed of interest.
2. Download the DEM data and unzip it (it will look something like this: 16020203_dem.exe and 16020203.shp)
3. Bring the shapefile into ArcView (at this point you could clip, with the use of the GeoProcessing extension, the specific area in the watershed in your area of interest).
4. Use the Projector! extension to project the dat geographic coordinates (decimal degrees) to your coordinate system of choice.
5. After loading the Spatial Analyst extension in ArcView, go to the Theme drop-down menu and select "Load Grid." ArcView will prompt you for a name location of the file to be converted. A conversion extent dialogue will pop up; select the name.shp name of the shapefile you are converting) for the Output Grid Extent combo box. The default value is acceptable but can be changed.
6. In the conversion field dialogue choose the field for which you want to convert the cell values (i.e., do you want your meters or feet?) Accept the prompt Join Feature Attributes to Grid and then you'll be given the option to add the theme to your current view.
7. Go to the File drop-down menu and select Expo Source...(this also requires the Spatial Analyst extension). Select the ASCII-Raster option as the file (it will export as a *.asc file).
8. Open WMS and from the File drop-down menu the Import command -- Import it as an Arc/Info grid->DEM.

STATSGO data using Arc/Info

STATE Soil GeOgraphic (STATSGO) data are soil maps prepared by NRCS developed by generalizing the detailed soil survey data. The base mapping scale is the USGS 1:250,000 topological quadrangle. Each map unit in STATSGO map is linked to the Soil Interpretations R...
(SIR) data base. The SIR includes physical and chemical properties of soil data, and interpretations for engineering use. STATSGO data are available in continuous statewide coverages. The data can be obtained in Arc/Info 7.0 coverage, GRASS 4.13 vector, and USGS DLG-3 for Because of the large mapping scale and generalization, the creation of STATSGO, it is not very useful for small urban watersheds.

The STATSGO database includes the HYDGRP field which contains the SCS hydrologic soil type. This field is used to obtain the composite curve numbers for the watershed. You must also have a landuse coverage and use table to do this.

There are seven basic steps to get an Arc/Info STAT coverage into a usable format for WMS:

1. Obtaining the data.
2. Projecting the coverage into your watershed's coordinate system.
3. Preparing a coverage to clip out the region of your watershed.
4. Clipping the STATSGO coverage.
5. Joining your attribute table with the database containing the HYDGRP field.
6. Converting your coverage into an Arcview shapefile which can be imported into WMS.
7. Importing your shapefile into WMS.

Following is a step by step procedure for obtaining STATSGO Arc/Info coverage and preparing it for use in WMS. For those who aren't familiar with Arc/Info, do Arc/Info commands in the spatial workspace. (use &workspace /dirname/dirname/.../spatial).

1. Download the coverage for the state that your watershed is located in.

- Go to the STATSGO Data Access page.
- Select the Form-based Download (it is the easiest).
- You will then have to provide information to register with the NRCS.
- After you submit your information it will give you a link back to the previous page. This page also contains links to other resources and data.

http://www.emrl.byu.edu/gishydrodata/tools.htm

8/25/99
the information you will need to uncompress th that you will be downloading.

Scroll down and select either DOS/WINDOWS or UNIX, whichever operating system you are run
on.

This will take you to the ftp directory. Select the directory and then the data directory. Then sele
state that your watershed is located in. For exa if my watershed was located in Utah I would sel
"ut.zip" or "ut.tar.Z" depending on my operatin system.

Follow the instructions on the Form-based dow page to uncompress the data. The Arc/Info cov
will be located in Spatial directory and named a the state abbreviation. Both of the directories i Spatial directory contain the files that make up Arc/Info coverage (for those who are not famili the directory structure of Arc/Info coverages).

2. Project the coverage from Albers Conical Equal Ar the planimetric coordinate system that your other watersheds data are in. Most of the time it will be el UTM coordinates or State Plane coordinates. But wh coordinate system you are using, be consisant. You find the projection arguments for the coordinate sys you are using in the Arc/Info help (enter help at the prompt).

Use the PROJECT command in ARC to project y coverage. Following is an example of projecting Utah coverage into UTM coordinates (your state likely have a different zone):

Arc: project
Usage: PROJECT <COVER | GRID | FILE>
<input><output>
Arc: project COVER ut ut1
Project: OUTPUT
Project: PROJECTION UTM
Project: DATUM NAD27
Project: UNITS METERS
Project: ZONE 12
Project: PARAMETERS
Project: END
Arc:
5. Use the CLEAN command to build polygon topology to your projected coverage.

   Arc: clean
   Usage: CLEAN <in_cover> {out_cover}
   Arc: clean ut1

3. Preparing a coverage to clip out the region of the watershed.

   - In the WMS map module, create a new coverage selecting Coverages... from the Feature Objects and then selecting the New button in the Cover dialog box.
   - Change the Attribute Set of your new coverage General and select OK.
   - Use the create feature arc tool to create a poly that completely encloses your watershed bound. Select this arc and select Build Polygon from th Feature Objects menu.
   - Select Export... from the File menu and then select the Feature object polygons -> Shapefile option.
   - Name and save your shapefile (*.shp, *.shx, a *.dbf) in the Spatial directory.
   - In Arc/Info, use the SHAPEARC command to convert this shapefile into an Arc/Info coverage. Then use the CLEAN command to build polygon topology. Follow is an example of these commands.

   Arc: shapearc
   Usage: SHAPEARC <in_shape_file> <out_cover {outsubclass}
   Arc: shapearc clipcov.shp clipcov
   Arc: clean clipcov

4. Clipping the STATSGO coverage.

   - Use the CLIP command to clip your STATSGO coverage with the clip coverage that you create. Following is an example of clipping the Utah ST coverage.

   Arc: clip
   Usage: CLIP <in_cover> <clip_cover> <out_cover>{POLY | LINE | POINT | NET | LIN RAW}
Arc: clip ut1 clipcov soilcov POLY

5. Now you need to join your clipped soils coverage attribute table with the database file that contains the HYDGRP field. This database file is named "comp".

Use the JOINITEM command to join your cover polygon attribute table (*.pat) with the "comp" database file. Use the MUID field as the relate it and the start item. Following is an example of the command.

Arc: joinitem
Usage: JOINITEM <in_info_file> <join_info_file> <out_info_file> <relate_item> <start_item>
Arc: joinitem soilcov.pat comp soilcov.pat MUID

6. Converting your coverage into an Arcview shapefile that it can be imported into WMS.

Use the ARCSHAPE command to convert your coverage into an Arcview shapefile. Following is an example of this command.

Arc: arcshape
Usage: ARCSHAPE <in_cover> <in_feature_class> <out_shape_file>
Arc: arcshape soilcov POLYS soilcov.shp

You are now ready to import your soil coverage WMS.

7. Importing the shapefile into WMS.

Create a new coverage in the map module by selecting Coverages... from the Feature Objects and then selecting the New button in the Cover dialog box.

Change the Attribute set to Soil Type.

Change the name of the coverage to indicate that a soil type coverage and select OK.

Select Import... from the File menu.

Select the Shape file -> Feature objects option select OK.
Under Polygons select the button.

Find and open the soils shapefile that you created.

You will notice in the window to the right of Poly that some text appears. This window shows which fields in your shapefile are mapped to WMS fields. Since the shapefile contained the field HYDGRP, automatically mapped it to the SCS soil type. If hydrologic soil type field was named something else, you could manually map it to the SCS soil type selecting the Attribute mapping button.

Select OK to finish importing your shapefile.

You now have a soils coverage that you can use to calculate composite curve numbers. Of course, you also have a land use coverage and a land use table for this.

Soils

Using EPA data (without the spatial analyst Arc extension)

1. Go to
   http://edcwww.cr.usgs.gov/doc/edchome/ndcd
   and obtain either a 7.5 or 1:250,000 DEM quad
   Note: The resolution for a 7.5 min quad is much better than the 1:250,000, i.e., a 7.5 min DEM data every 30 meters while a 1:250,000 has data every 90 meters.
2. For the 7.5 min quads follow the instructions on tools/utilities page to convert this data into grid readable for WMS) format.
3. Import the DEM into WMS.
4. Using the Create Feature Arc tool in the WM module to create a polygon that completely encloses your watershed boundary. Select this arc and Build Polygon from the Feature Objects menu. Select Export... from the File menu and then select the Feature object polygons -> Shapefile option.
5. Add this shapefile into a view in ArcView.
6. Go to http://www.epa.gov/OST/BASINS/gisdat to obtain soil type and landuse data for the gen
region where the DEM data is located.
7. Add these shapefiles to the current view and, u
the GeoProcessing Wizard, clip out the soil type
landuse data corresponding to the DEM data.
"Clip" instructions here.
8. Join corresponding MUID fields in ArcView.
    - Add the Statsgo.shp file in a View window.
    - Go to the project dialogue and single click
      icon [Tables] then click on Add in the top rig
      same dialogue.
    - Select the Statsgoc.dbf file.
    - Select the MUID field in both the Stats.go.d
      Statsgoc.dbf files. Make sure the Stats.go.
      the active table.
    - In the Table drop-down menu select Join ( fields will be visually added to the Statsg
      Creat a new "dummy" field.
        From the Table drop-down menu sele Editing.
        From the Edit drop-down menu select give it a name and select Type String
        Select the "dummy" field and then select t
      icon [ ] (note: this macro will not be activ
      you are still in Edit mode).
      - Double-click the Hygrp field (i.e., the defa
        dummy = )
      - In the Table drop-down menu select Remo
      Create a new field called Hydgrp and copy
      contents of "dummy" into Hydgrp using th macro (see above). Note: If you don't ad
      field and copy the information in as descri
      (i.e., you make an alias to the "dummy" fi
      dummy field will have to be mapped manu

*Soils*
The EPA Basins soils data is also in shapefile format. works very well in WMS since the soil data must be i shapefile format to bring in as a soil coverage.

---

**Landuse (EPA GIRAS to Arc/Info interchange**

http://www.emrl.byu.edu/gishydrodata/tools.htm

8/25/99
format)

The EPA has created an ftp site which contains USG landuse and landcover data which has been convert the GIRAS format into Arc/Info interchange (*.e00)

If you do not want to use the EPA landuse data tha already in shapefile format you can still use original landuse data without Arc/Info (see Arc/Info direction GIRAS data above).

Download the necessary data at:

- egiras-ARC/INFO export compressed files the 86 degree longitude.
- mgiras-ARC/INFO export compressed files between the 86 degree and 110 degree lon
- wgiras-ARC/INFO export compressed files of the 110 degree longitude.

The metadata describes the naming conve for the A/I export files found in the other directories. Each filename begins with a let followed by the first two characters of the quadrangle name. The 5 digits in the filena represent the latitude and longitude of the southeast corner of the quad. For example Baltimore quad would be represented as "iba39076" and Denver quad would be represented as "ide39104".

- Unzip the data
- Use Import 71 to convert the Arc/Info interchan the native ArcView format.
- Add the result to a view in ArcView.
- In the Theme drop-down menu select the Conv Shapefile... option - it will then prompt you to s destination for the shapefile.
- Import your landuse shapefile into WMS.
  - In the WMS map module, select Coverages from the Feature Objects menu.
  - Create a new coverage and change the att set to Land Use. Select OK.
  - Select Import... from the File menu.
  - Select the Shape file -> Feature Objects op and select OK.
  - Select the Open button under Polygons.
Find and open the land use shapefile that you created.
Select the Attribute mapping... button under Polygons.
Select LANDCOV_ID (or COVERNAME_ID) in the upper left window and Land use in the upper right window. The COVERNAME_ID field contains the classification codes that define the land cover for each polygon. You can find the classification code descriptions in the Appendix of the U.S. Department of Agriculture homepage.
Select the Map button and then select the button. Note: It takes quite a while to load this shape file. I couldn't load it in at all in version 5.1 but it works in version 6.0 (not sure why).

For problems or general questions regarding this web contact the webmaster.
Last updated: August 14, 1999.
Introduction

The WMS-Hydro extension for ArcView 3.x helps to prepare and transfer GIS data from ArcView to WMS. It is intended for use with vector data sets and does not require the Spatial Analyst extension for ArcView, but if you do have Spatial Analyst it will help to manage import and export of grid data sets for use with WMS. Further, you will likely be able to take advantage of other extensions developed for hydrologic data development.

Functionalities

- Attributes mapping -- Maps ArcView® table fields as WMS attributes.
  - Tutorial on Managing Attributes
- Outlet creation -- Creates an outlet them in ArcView
  - Tutorial on outlet creation
- Stream editing and ordering -- Assures topologic connectivity and correct ordering for direct implmentation into WMS.
  - Tutorial on Stream Editing
  - Tutorial on Stream ordering
- Exporting ArcView® shapefiles and grids -- Exports shapefiles, DEMs, and grids by saving a WMS super file which could be read directly into WMS.
  - Tutorial on Exporting and Importing data from ArcView to WMS
- Computing Composite Curve Numbers (CN) -- WMS can compute composite curve numbers from land use, soil type, and basin boundary shape files.
  - Tutorial on computing Composite Curve Numbers with WMSHydro

http://www.emrl.byu.edu/gishydrodata/wmshydro.htm

8/25/99
all tutorials written by Nawajish Sayeed Noman

Download the wmsavext.exe file
This file contains the WMSHydro extension along with the user manual (.pdf file) and a couple tutorials to get you started.

For problems or general questions regarding this web contact the webmaster.
Definitions

NRCS composite curve number -- An areal average of the curve numbers for the watersh subregions. A curve number is a numerical d of the impermiability of the land in a watersh number varies from 0 (100% rainfall infiltrati (0% infiltration - i.e., pavement). This numb applied to the NRCS curve number method t value for rainfall excess.

Geo-Referencing -- A term used in combinati background or base maps (usually DRG files georeferenced 7.5' topographs). A georeferere image has a coordinate system that is in som associated with the image itself. This allows modeler to compare, in a spatially correct see other layer data (soil type, landuse, hydrogra stream reaches etc., and DEMs) with the top

Data Format -- This refers to the file type. Fi such as Arc/Info interchange files (*.e00 - us 71), ArcView shapefiles (*.shp), Arc/Info gri are readily usable formats in ArcView and W files types/formats such as STDS (though W 6.0 reads in STDS files directly, GIRAS, Arc binary files, AutoCad dwg files (this can be c ArcView with the use of the Cad Reader exte ArcView).

Projection -- Projections can be classified int different categories:
- Geographic -- usually in reported in dec degrees
- Everything else -- everything else is bas specific shapes (conical, cylindrical, spheroid/sphere) which can regionally e spatial accuracy due to shape characteri specific to the region of study.

**Coordinate System** -- The link to the left is an resource describing the background and origi coordinate systems.

**WMS** -- Watershed Modeling System. A pr processor to lumped parameter models such TR-55, HEC-1 as well as distributed hydrolo such as CAS2D. Automates messy model te editing and provides an accurate visual repre model output.

**Hydrography** -- Hydrography is the study of rivers, and other bodies of water with regard measurement of flow and investigation of the of streams. Special reference to the control, u of waters, measurement of tides and currents, surveying, sounding, and charting of bodies additional aspects of hydrographic investigat

**TIN** -- Triangulated Irregular Network: Alter format used to represent topographic features elevation.
• More accurate representation of surface points are not restricted to lie on a (i.e., a 30m x 30m DEM) high density of points where there is variation in surface features A modeler might want to use a base DRG) to apply additional vertical topographic contours to increase elevation resolution.

• Allows modeler to conform to drainage can have actual drainage boundary (a D boundary is sometimes represented as a This is also true with streams; streams i will follow a "stair-case" pattern - greater refinement in a TIN allows the modeler to represent stream flow.

DEM/DTM -- Digital Elevation Model, Digit Model (more general term)

USGS DEMs -- The 7.5' (30m) DEM is derived by digitizing USGS 1:24000 scale quad map gives less accurate results) or by scanning aerial photographs (now exclusively involving the Aerial Photography Programme quad-centre photographs). Note that the vertical scale of the DEMs may be in feet (in areas lower relief) or in areas of higher relief).

Some of the 7.5' DEMs (notably those captured digitizing existing map sheets) are regarded as relatively poor quality, particularly in places of relief. Also they are often not well edgemated result of being produced on the basis of individual sheets. Significant gaps have been observed on quads. Data interpolation is really the only viable method of filling these gaps.
Importantly the 7.5' DEMs are referenced to a cartesian coordinate system, whereas all other DEMs are referenced to geographical (latitude coordinates).

The 30' and 15' DEMs are closely related to the continental US. Each 30' DEM is also available as four 15' DEMs. These products were produced from digital contours obtained from maps at 1:24K and 1:100K scale or from resampling. They are referenced to North American Datum (NAD 27) or NAD 83. Elevations may be in feet. Elevations located on the minute lines (sides) correspond with the same profiles on a DEM block.

The 1 Degree DEM consists of a regular array of elevations referenced horizontally to the geographical (latitude/longitude) system of the Geodetic System 1972 (WGS 72) or, for a few regions, the WGS 84 Datum. Note that the World Geodetic System is significantly different to the North American Datum (NAD) used to reference the 7.5' DEM. Conversion is possible, but is not trivial. Elevations located on the degree lines (all four sides) correspond with the same profiles on adjoining DEM blocks.

Elevations are in meters relative to mean sea level. Spacing of the elevations along and between profiles is 3 arc-seconds with 1201 elevations. The only exception are DEMs in Alaska, where spacing and number of elevations per profile depends on the latitudinal location of the profile. Latitudes between 50 and 70 deg. north have 6 arc-seconds with 601 elevations per profile. Latitudes greater than 70 deg. north have 4 arc-seconds with 401 elevations per profile. *(The above DEM information is located at*
HEC-1 -- A watershed computer program models the precipitation-runoff process. Represented by basic model components: pre-runoff, channel routing, reservoir routing, divide hydrograph combinations that are used to estimate hydrographs at various locations. Other capabilities include automatic parameter estimation and flood damage analysis. The model is limited to sinusoidal analysis and routing techniques account for dynamic backwater conditions.

TR20 -- A physically based event model which computes direct runoff resulting from any synthetic rainstorm. There is no provision for initial abstraction or infiltration during perioic rainfall within an event. Peak discharges, the occurrence, water surface elevations and durations can be computed at any desired cross section. Complete discharge hydrographs can be obtained. The model provides for the analysis of nine different rainstorm distributions over a range of recurrence interval peak discharge for unregulated and urban watersheds.

NFF -- A compilation of all the current state metropolitan area regression equations into one program. NFF includes regression equations estimating flood-peak discharges and techniques estimating a typical flood hydrograph for a given recurrence interval peak discharge for unregulated and urban watersheds.

Shapefile -- vector data representation supported by ESRI for ArcView. Advantages/Characteristics...
Faster drawing speed (within the software)
Easy to edit
Require a small amount of disk space
ArcView uses shapefiles the same way coverages (easy to understand and implement)
Consists of a main file (*.shp) and index (*.shx) and a database file (*.dbf)
- *.shp -- A direct access, variable-record-length file in which each record describes a shape with a list of vertices.
- *.shx -- Each record contains the offset of the corresponding main file record from the beginning of the main file.
- *.dbf -- The database table contains attributes with one record per feature.

Attributes -- These are the alpha or numeric characteristics which describe a given spatial feature. Attributes are commonly stored in a relational structure of a flat ASCII file. Common attributes for hydrographic databases of streams would include name, length, and direction.

Topology -- A mathematical method used to define spatial relationships. Topology defines the logical geographical phenomena relative to each other independent of distance or direction. Topology requires connectivity of one entity to another. Topology is required for proper associations to be made among features such as arcs, nodes, points, and polygons and their attributes.
Polygon -- A closed loop of $x$, $y$ coordinate points define the boundary of an area. The polygon is defined by a series of straight lines, arcs, or combinations of both. Examples are watersheds.

Contiguous -- In drainage areas, physical features occur with enough frequency and close enough proximity to alter hydrologic characteristics or watershed.

Hydrologic Unit (HU). An area of land upstream in a stream (designated as the outlet), which is defined by a hydrologic boundary, includes all of the source area that could contribute surface water runoff directly and indirectly to designated outlet point. The HU may also be associated with surface areas such as related contruction and drainage, non-contributing, and trans-basin areas, to form a landform associated with the designated outlet point. It may also have one or more hydrologic units completely within the upstream drainage area. Earlier ve

Hydrologic Unit Code (HUC). The identifier for a specific HU. It is determined by an establishment of assigning numbers and alpha characters in order and in different fields of a composite code (Watershed and Subwatershed, 11 and 14) that represents specific subdivisions of the nation at different levels of detail or size. The follo
four levels of delineation plus the NRCS met
next two levels of sub-division:
First 2 fields are the Region 01
Next 2 fields are the Sub-region 0108
Next 2 fields are the Accounting Unit (NRCS - "Basin") 010802
Next 2 fields are the Cataloging Unit (NRCS - "Subbasin") 0108
Next 3 fields are the NRCS Watershed 01080204010
Next 3 fields are the NRCS Subwatershed 01080204010010
(http://www.ftw.nrcs.usda.gov/HUC/usersguide.htm)

Grid/Raster data -- Gridded cells, blocks or p
to overlay and perform analysis, objects are
true dimension when represented in a raster f

Advantages of raster data:

- Simple data structure
- Easier to perform analysis
- Straightforward ties to remote sensing data
- Lends well to hydrologic modeling

Disadvantages of raster data:

- Spatial inaccuracies are more prevalent
- No WYSIWYG
- Low resolution or tremendous data storage requirements
- Every cell must have an attribute

Vector data -- Vector data is map like, has m
precised boundaries (than gridded data), topo
basic building blocks: points, lines, polygons

Advantages of vector data:


- More maplike (WYSIWIG)
- Higher resolution
- High spatial accuracy
- Topological
- Less computer storage needed to store
- More intuitive, easier to understand what seeing

Disadvantages of vector data:

- More complicated data structure can be difficult to manage
- Requires "high tech" computers and software, eventually more expensive

Geotiff -- The GEOTIFF GeoTIFF format is a non-proprietary geographic TIFF format. The purpose of GeoTIFF is to provide information that lets imagery (scanned maps, satellite images, remote geographic analysis, etc) be read automatically in the correct position and scale within many GIS systems. GeoTIFF implements a tag structure which embeds geographic information methodically and invisibly to most users inside the TIFF format.

http://www.census.gov/cgi-bin/geo/gisfaq?Q3.14 mikeruth

For problems or general questions regarding this web contact the webmaster.
Examples

Links to examples (and projects) representing some of the capabilities/uses of a GIS and WMS in hydrologic modeling are listed below:

GeoProcessing Wizard -- Download a copy of the GeoProcessing extension

Watershed Modeling with GIS and the Watershed Modeling System (WMS) by Chris Smemoe

Chris is now a principle developer of WMS in the EMRL department here at BYU. The above is a link to his CEE 514 project -- an excellent resource!

TRANSFORMING SWAMPLAND INTO NAUVOO, The City Beautiful - A Civil Engineering Perspective Fairly comprehensive view of the many applications (above and beyond the modeling part itself) for which WMS might be employed (along with GIS data) in the modeling process; i.e., registering an image, digitizing, creating a TIN, overlaying an image on a TIN etc.

Using GIS in Watershed Modeling -- Learn about merging DEMs, image registration, digitizing contours, converting contour data to grid data, and hillshading.
GeoProcessing

Purpose: Become familiar with ArcView Geoprocessing utilities.

Introduction
A combined road network project has been launched by three states Utah, Wyoming and Colorado. As a GIS Analyst first you have to prepare a project database from available themes. You also have to carry out few analyses in order to help planners.

Available Themes
Copy/Save geoproc.exe in your local directory and extract the following themes.
1. County: County boundaries of Wyoming and Colorado.
2. CntyUtah: County boundaries of Utah.
3. Roads: Road network of USA.
4. Rivers: River network of USA.

Loading Geoprocessing Extension
1. Select Extensions... from File menu.
2. Check Geoprocessing from Extensions dialog.
3. Press OK button to close the dialog.

Processing
Open a new view and load all available themes.

1. Create a new theme CountyAll by
merging County and CntyUtah.
a) Select GeoProcessing Wizard... from View menu to open GeoProcessing dialog. (You have to have the Geoprocessing extension loaded).
b) Choose the operation Merge themes together from available operations. Press Next.
c) Select County.shp - polygon and CntyUtah.shp - polygon from list of themes.
d) Specify output theme CountyAll.shp (don't forget to navigate to your local directory). Press Finish.
Wait few seconds, you will have CountyAll.shp loaded in the view.

2. Create state boundary theme State by dissolving county broundaries from CountyAll theme using State_name as attribute.
a) Select GeoProcessing Wizard... from View menu to open GeoProcessing dialog. (You have to have the Geoprocessing extension loaded).
b) Choose the operation Dissolve features based on an attribute from available operations. Press Next.
c) Select CountyAll.shp from Select theme to dissolve combo box.
d) Select State_name from Select an attribute to dissolve combo box.
e) Specify output theme State.shp (don't forget to navigate to your local directory). Press Next.
f) Don't select any other field, just press Finish.
After few seconds, you will have State.shp
loaded in the view.

3. Clip Roads using State as a clip cover and create a new theme RoadClp.
   a) Select GeoProcessing Wizard... from View menu to open GeoProcessing dialog. (You have to have the Geoprocessing extension loaded).
   b) Choose the operation Clip one theme based on another from available operations. Press Next.
   c) Select Roads.shp from Select input theme to clip combo box.
   d) Select State.shp from Select a polygon overlay theme combo box.
   e) Specify output theme RoadClp.shp (don't forget to navigate to your local directory). Press Finish. After few seconds, you will have RoadClp.shp loaded in the view.

4. Similarly clip Rivers using State as a clip cover and create a new theme RiverClp.
   a) Select GeoProcessing Wizard... from View menu to open GeoProcessing dialog. (You have to have the Geoprocessing extension loaded).
   b) Choose the operation Clip one theme based on another from available operations. Press Next.
   c) Select Rivers.shp from Select input theme to clip combo box.
   d) Select State.shp from Select a polygon overlay theme combo box.
   e) Specify output theme RiverClp.shp (don't forget to navigate to your local directory). Press Finish. After few seconds, you will have RiverClp.shp loaded in the view.
5. Create another new theme RoadInt by intersecting RoadClp with CountyAll.
a) Select GeoProcessing Wizard... from View menu to open GeoProcessing dialog.
(You have to have the Geoprocessing extension loaded).
b) Choose the operation Intersect two themes from available operations. Press Next.
c) Select RoadClp.shp from Select input theme to intersect combo box.
d) Select CountyAll.shp from Select an overlay theme combo box.
e) Specify output theme RoadInt.shp (don't forget to navigate to your local directory).
Press Finish. After few seconds, you will have RoadInt.shp loaded in the view.
f) Make the RoadInt.shp theme active and press Open Theme Table button.
g) Select the field Name and press Sort Ascending button.

6. Get county name from CountyAll theme into MajCities theme using spatial join.
a) Make the MajCities.shp theme active and press Open Theme Table button.
b) Make a list of fields available in that table. Close the table.
c) Select GeoProcessing Wizard... from View menu to open GeoProcessing dialog.
(You have to have the Geoprocessing extension loaded).
d) Choose the operation Assign data by location from available operations. Press Next.
e) Select MajCities.shp from Select a theme to assign data to combo box.
f) Select CountyAll.shp from Select a theme to assign data from combo box. Press Finish.
After few seconds data will be transferred to MajCities.shp.
e) Again make the MajCities.shp theme active and press Open Theme Table button.

For problems or general questions regarding this web contact the webmaster.
Search

Use the form below to search for documents in this web containing specific words or combinations of words. The text search engine will display a weighted list of matching documents, with better matches shown first. Each list item is a link to a matching document; if the document has a title it will be shown, otherwise only the document's file name is displayed. A brief explanation of the query language is available, along with examples.

Search for: ____________________________

Start Search | Clear

Query Language

The text search engine allows queries to be formed from arbitrary Boolean expressions containing the keywords AND, OR, and NOT, and grouped with parentheses. For example:

information retrieval
finds documents containing 'information' or 'retrieval'

information or retrieval
same as above
information and retrieval
finds documents containing
both 'information' and
'retrieval'

information not retrieval
finds documents containing
'information' but not 'retrieval'

(information not retrieval)
and WAIS
finds documents containing
'WAIS', plus 'information' but
not 'retrieval'

web*
finds documents containing
words starting with 'web'

Back to Top

For problems or general questions regarding this web contact the webmaster.
Spatial Data Acquisition

Introduction

In the past few years the availability of hydrologic modeling data layers, including digital elevations, stream reach, basin boundaries, land use, and soil-type in GIS format has become common place. GIS has established itself as an excellent tool for data storage and management. The Watershed Modeling System (WMS) was designed to use these and other data sets to set up hydrologic simulations for HEC-1, HEC-HMS, HSPF, TR-20, NFF, Rational Method, and other lumped parameter models.

This web page was written to aid hydrologic modelers in understanding the entire scope of GIS-based model development, from data acquisition through model numerical analysis in ArcView and/or WMS. Though written for a specific audience (WMS users) the concepts and data descriptions can serve as a valuable resource for a wide range of environmental modelers.

Enter WMS/GIS Data Acquisition Page